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Chhattisgarh Secretariat

Notations :
1.Options shown in green color and with # icon are correct.

2.0Options shown in red color and with # icon are incorrect.

Question Paper Name : CG Secretariat AG3 QP 7
Subject Name : CG Secretariat AG3
Creation Date : 2021-12-10 17:47:27
Duration : 60

Total Marks : 50

Display Marks: Yes

Share Answer Key With Delivery Engine : No

Calculator : None

Magnifying Glass Required? : No

Ruler Required? : No

Eraser Required? : No

Scratch Pad Required? : No

Rough Sketch/Notepad Required? : No

Protractor Required? : No

Show Watermark on Console? : Yes

Highlighter : No

Auto Save on Console? ( SA type of questions will be always auto saved ) : Yes

CG Secretariat AG3
Group Number : 1
Group Id : 1465877
Is this Group for Examiner? : No

General Knowledge of Chhattisgarh

Section Id : 14658713
Section Number : 1

Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 25
Number of Questions to be attempted : 25
Section Marks : 25
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 14658713
Question Shuffling Allowed : Yes

Question Number : 1 Question Id : 146587301 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

The Bastar highland, known as , lies south of Chhattisgarh basin.
Options :

1465871201. ¥ Raigarh Plateau

1465871202. ¥ Maikal Caves

1465871203. ¥ Dandakaranya

1465871204. ¥ Dharamjaigarh

Question Number : 1 Question Id : 146587301 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

TWR I UfH (Bastar highland), oY ¥ T Y ST o1 B, BYG S & S H fRua j
Options :

1465871201, % VTG TSR

1465871202, % HehTel [HTT

1465871203, ¥ TSHRUY
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1465871204, % YHSIATG

Question Number : 2 Question Id : 146587302 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

According to Agro-Climatic Zones of Chhattisgarh, district is situated in the Chhattisgarh Plains.
Options :

1465871205. ¥ Balrampur

1465871206. ¥ Jashpur

1465871207. ¥ Sukma

1465871208. ¢ Durg

Question Number : 2 Question Id : 146587302 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

BTG & HV-SIerarg S & 4R, frem e<itenTg & HeH! 8 fRYq B
Options :

1465871205, % TERTYR

1465871206. % SIRIYX

1465871207. * D HT

1465871208, ¢ it

Question Number : 3 Question Id : 146587303 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

What is the name of the renowned freedom fighter who launched the monthly magazine 'Chhattisgarh Mitra' in the year 1900?
Options :

1465871209. ¢ Pandit Madhav Rao Sapre

1465871210. ¥ Hanuman Singh

1465871211. ¥ Narain Singh

1465871212. ¥ Babu Chhotey Lal Shrivastava

Question Number : 3 Question Id : 146587303 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Ty 1900 H WY UfeT w<iaTe o &1 fSre A IHRY e o, 39 URig Tacisar S & ATH o1 82
Options :

1465871209. ¢ UfSd A18d 3@ I

1465871210. % BIAF Rig

1465871211, % AR R

1465871212, % SIEBIc A Sl

Question Number : 4 Question Id : 146587304 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

The Kabir panthis came to Chhattisgarh in period.
Options :

1465871213. % The Gupta Period

1465871214. % The Satavahana Period

1465871215. ¢ The Mughal

1465871216. ¥ The Khalji

Question Number : 4 Question Id : 146587304 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
HaR g 3afy H BheTe 3mu|
Options :

1465871213, # Tt HTd

1465871214, ¥ HIddigd dId
1465871215. ¢ HiTcl

1465871216, % Raaait
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Question Number : 5 Question Id : 146587305 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
When the Halba rebellion was started?
Options :

1465871217. # 1855

1465871218. ¥ 1774

1465871219. # 1798

1465871220. # 1832

Question Number : 5 Question Id : 146587305 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
Ferdl fI5ig el Y g3 U1
Options :

1465871217. % 1855

1465871218. ¥ 1774

1465871219. ¥ 1798

1465871220. # 1832

Question Number : 6 Question Id : 146587306 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Which day is observed as Chhattisgarhi Rajbhasha Diwas since 2007, when Chhattisgarhi was given the status of state language in the Vidhan
Sabha?

Options :

1465871221. ¥ 28th May
1465871222, % 28th July
1465871223. ¥ 28th September
1465871224, ¢ 28th November

Question Number : 6 Question Id : 146587306 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

2007 & 1 fb g feT ) SIS ISTHTYT G & =0 | AR STl B, O ST bl AT H I HIST BT S foram T T2
Options :

1465871221, % 28 g

1465871222, % 28 JaTs

1465871223, % 28 RideR

1465871224 ¢ 28 AdsR

Question Number : 7 Question Id : 146587307 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Which festival of Chhattisgarh is committed to the reverence of 'Mother Earth'?
Options :

1465871225, ¥ Kajari Festival

1465871226. ¥ Goncha Festival

1465871227. % Surhul Festival

1465871228. ¥ Madai Festival

Question Number : 7 Question Id : 146587307 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

TG BT DI T AER '¢Rat AT DT gl H FERT 1 82
Options :

1465871225, % HoR} Agld

1465871226. % e AgITa

1465871227, ¢ ¥Rgd Holod

1465871228, % TS HEId

Question Number : 8 Question Id : 146587308 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
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Correct Marks : 1 Wrong Marks : 0

With which dance form was the famous folk dancer Devdas Banjare associated?
Options :

1465871229. ¥ Raut Nacha

1465871230. ¥ Panthi Dance

1465871231. ¥ Rahas

1465871232. # Hareli

Question Number : 8 Question Id : 146587308 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

RIS Addd qaard soR e T At A IS &
Options :

1465871229. % 3 I

1465871230, ¢ Ul S/

1465871231, ¥ Ig9

1465871232, % BT

Question Number : 9 Question Id : 146587309 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Which of the following ornaments of Chhattisgarh is worn in the nose?
Options :

1465871233,  Phulli/Phuli

1465871234. ¥ Ainthi

1465871235, # Tilari

1465871236. ¥ Nangamori

Question Number : 9 Question Id : 146587309 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
BTG BT FTTRIT BIF TT ST AT H U1 STl 32

Options :

1465871233, ¢ et
1465871234, % U3}
1465871235, * faast
1465871236, % AR

Question Number : 10 Question Id : 146587310 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

With which singing style was the noted singer Suruj Bai Khande associated?
Options :

1465871237. ¥ Pandavani

1465871238. ¥ Goura

1465871239. ¥ Khaduwa

1465871240. % Bharthari

Question Number : 10 Question Id : 146587310 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

T3 T et § TReTd M Rt ST Wi e A
Options :

1465871237, % USATT

1465871238, # TIRT

1465871239, # @gdl

1465871240, ¢ WRU

Question Number : 11 Question Id : 146587311 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
As per the provisions of the Constitution of India, in order to be appointed as the Governor of Chhattisgarh, what is the minimum age required?
Options :
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1465871241, ¥ 25
1465871242. % 30
1465871243. ¥ 35
1465871244, % 40

Question Number : 11 Question Id : 146587311 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

YR P GRAYH F Wyl & IR SUGIG & AequTd & U § Fged g1 & o S1awads <g-dH 3i1g & 31 82
Options :

1465871241, ¥ 25

1465871242, % 30

1465871243, ¢ 35

1465871244, % 40

Question Number : 12 Question Id : 146587312 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

The advocate general of the state of Chhattisgarh is appointed by the
Options :

1465871245, # Chief Justice of High Court

1465871246. ¥ Chief Minister of Chhattisgarh

1465871247. ¢ Governor of Chhattisgarh

1465871248. ¥ Chief Justice of Supreme Court

Question Number : 12 Question Id : 146587312 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

BTG AT & AR (TSAhe SIFRT) Bl ¥ gR1 frgad foman SraT 81
Options :

1465871245, % I <RI o T TN

1465871246, % BTG & AU
1465871247, ¢ BTG & ATUTd
1465871248, % T PHIE P T ranefisr

Question Number : 13 Question Id : 146587313 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Under Article 213 of the Constitution, when the House is not in session, if the Government wants to introduce any law, he/she issues s
which contains legal provisions.

Options :

1465871249. # ordinance
1465871250. * injunction
1465871251, % ruling
1465871252. % protocol

Question Number : 13 Question Id : 146587313 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

I P 3T 213 P T4, I o T H 781 31l 8, I WXPR PIg DI AN AT 18l 8, 1 98 S et B, Rt
BT U i g

Options :

1465871249, ¢ ST

1465871250, % 3SR

1465871251, % ARG

1465871252, % TCIpId

Question Number : 14 Question Id : 146587314 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

‘Who presides over the House in the absence of the Speaker?
Options :

1465871253. # Chief Minister
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1465871254. ¥ Home Minister
1465871255. ¥ Member from the Panel of Chairman
1465871256. ¥ Governor

Question Number : 14 Question Id : 146587314 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

iR (Speaker) P Hﬂ@lﬁﬁwaﬁ G{W&HT@:TWT%?
Options :

1465871253, % TRIHA

1465871254, % T8 WAl

1465871255, ¥ IIREA & T & W=

1465871256. % ITUT

Question Number : 15 Question Id : 146587315 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

How many coal fields are there in Chhattisgarh?
Options :

1465871257. # 9

1465871258. % 10

1465871259. ¥ 12

1465871260. ¥ 14

Question Number : 15 Question Id : 146587315 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
BTG W $ fba S &= 82
Options :

1465871257. # 9

1465871258. % 10

1465871259. ¥ 12
1465871260. ¥ 14

Question Number : 16 Question Id : 146587316 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Iron ore deposits of Chhattisgarh are associated with the rocks that are world over known to contain:
Options :

1465871261. * Magnetite

1465871262. ¥ Hematite

1465871263. # Limonite

1465871264. ¥ Siderite

Question Number : 16 Question Id : 146587316 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

BUNRTG & TG S HER I IgHI U IS 8, o gfHar 1R & & w0 & 1 oIrell 8-
Options :

1465871261, % TICIST (Magnetite)

1465871262 ¢ BHCIZC (Hematite)

1465871263. # fAMISE (Limonite)

1465871264, % RISIET (Siderite)

Question Number : 17 Question Id : 146587317 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

The aluminium extraction plant of BALCO is operational at which district of Chhattisgarh ?
Options :

1465871265. % Bilaspur

1465871266. # Raipur

1465871267. % Sukma
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1465871268. ¥ Korba

Question Number : 17 Question Id : 146587317 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

BTG AT BT Fleh! (BALCO) BT TegHi-aH fshur wie S d PrRa g
Options :

1465871265, % fI@IQR

1465871266, % IAYR

1465871267, % FHHAT

1465871268, ¥ HIRET

Question Number : 18 Question Id : 146587318 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

In the NITI Aayog's "Healthy States, Progressive India" list released in June 2019, under which category does the state of Chhattisgarh figure?
Options :

1465871269. ¥ Front-runners

1465871270. ¢ Achievers

1465871271. ¥ Aspirants

1465871272. ¥ Laggards

Question Number : 18 Question Id : 146587318 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

T 2019 7 SR g3 -y SmanT Bt ey sy, wfRiia URA 3 I A wxinTe I g St & sicria simar g2
Options :

1465871269. * The TTH

1465871270. ¢ 3

1465871271, % 3{Tapielt

1465871272, % ftharg!

Question Number : 19 Question Id : 146587319 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
Maria revolt, one of the major tribal rebellions, took place during which of the following years?

Options :

1465871273. = 1870-1881
1465871274, * 1814-1835
1465871275. ¥ 1842-1863
1465871276. * 1881-1892

Question Number : 19 Question Id : 146587319 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

nfegrmfsar fage (Maria revolt),@%Wm%ﬁﬁﬁwg,ﬁmﬁﬁwaﬁ%wgaﬁ
Options :

1465871273, ¥ 1870-1881

1465871274. % 1814-1835

1465871275. ¥ 1842-1863

1465871276. % 1881-1892

Question Number : 20 Question Id : 146587320 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

‘Who among the following led the revolt of Paralkot?
Options :

1465871277. ¥ Thakur Pyarelal Singh
1465871278. ¢ Gend Singh

1465871279. ¥ Gopinath Kapardas

1465871280. ¥ Vir Narain Singh
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Question Number : 20 Question Id : 146587320 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

fofafed & § i wasic & fagis &1 g far am
Options :

1465871277. % BTGHR WRATA Rig

1465871278, ¢ i Rig

1465871279. % TNUHTY UG

1465871280. # dR IR0 Rig

Question Number : 21 Question Id : 146587321 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Which among the following is the state agency engaged in the exploration of mineral resources in Chhattisgarh?
Options :

1465871281. # Chhattisgarh Environment Conservation Board

1465871282. # Indian Bureau of Mines

1465871283. ¢ Directorate of Geology and Mining

1465871284. ¥ Container Freight Depot

Question Number : 21 Question Id : 146587321 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

fofifed & 9 o I te Tsa ok @ S gdie § af e g ot @i § @ gs 82
Options :

1465871281, % BTG TAfaRUT W&V Hed

1465871282, % YR @ &R

1465871283, ¢ Yfaq™= 3R T FE=ITE (Directorate of Geology and Mining)
1465871284, % &R The fUI (Container Freight Depot)

Question Number : 22 Question Id : 146587322 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

The famous play 'Unch Neech' is written by which author of Chhatisgarh?
Options :

1465871285. ¢ Khub Chand Baghel

1465871286. ¥ Ambar Shukla

1465871287. ¥ Tejpal Soni

1465871288. * Shiva Bajpai

Question Number : 22 Question Id : 146587322 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

URIg Alee $F 114 BTG P (g oad - forar g2
Options :

1465871285, ¥ Gadg ad

1465871286, % 3FER ol

1465871287, % qoUTel ST

1465871288, % Rrar SroTot

Question Number : 23 Question Id : 146587323 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

The pithora style of Chhattisgarh tribe is type of .
Options :

1465871289. # Wood carving

1465871290. ¥ Painting

1465871291. ¥ Metal Carving

1465871292. # Dance

Question Number : 23 Question Id : 146587323 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
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Correct Marks : 1 Wrong Marks : 0

BTG STl I AIRT AN T UPR BB BV/Er gl
Options :

1465871289. # Thal U TGhTRM

1465871290. ¢ REFGRY

1465871291, % &1 TR THPBIRA

1465871292, % T

Question Number : 24 Question Id : 146587324 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

As per FSI report 2017, what percentage (approximate) of total area of Chhattisgarh is covered under forests?
Options :

1465871293. ¥ 41.33%

1465871294, # 25.97%

1465871295, ¥ 12.28%

1465871296. ¥ 59.25%

Question Number : 24 Question Id : 146587324 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

FSI BT RUIE 2017 & SR, BTG & $A SABE BT T UaI=Id (ITHI) &5 971 & Sfafa 317 g2
Options :

1465871293. ¥ 41.33%

1465871294. % 25.97%

1465871295, # 12.28%

1465871296. ¥ 59.25%

Question Number : 25 Question Id : 146587325 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
Where is CHIRIMIRI coal field located in Chhattisgarh?

Options :

1465871297. ¥ Dhantewada district
1465871298. ¢ Korea district
1465871299. # Durg district
1465871300. * Surajpur district

Question Number : 25 Question Id : 146587325 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
BeirrTe § R wiaen & el fRud 22
Options :

1465871297, * ddaraT forar

1465871298. & BT fora

1465871299. % gif foran

1465871300. % FIOTYR forarr

Computer Knowledge

Section Id : 14658714
Section Number : 2

Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 25
Number of Questions to be attempted : 25
Section Marks : 25
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 14658714
Question Shuffling Allowed : Yes

Question Number : 26 Question Id : 146587326 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
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Correct Marks : 1 Wrong Marks : 0

Which of the following input devices is used where one out of a few alternatives is to be selected and marked using a pen or pencil?
Options :

1465871301. % MICR device

1465871302. ¥ OMR device

1465871303. ¥ Barcode reader

1465871304. # Digitiser

Question Number : 26 Question Id : 146587326 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

%Wﬁ@ﬁﬁmwﬁﬁqmﬁmwmwmﬁamﬁ%a%mma,aﬁmﬁ%ﬁmw%amww
ISIGH

Options :

1465871301. ¥ MICR f$arsy

1465871302. ¢ OMR fgarsq

1465871303, # TRBIS JeX

1465871304, % TSforegoR

Question Number : 27 Question Id : 146587327 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Which of the following keys is used to generate a 'new line' character?
Options :

1465871305. * Tab

1465871306. ¥ Enter

1465871307. # Shift

1465871308. # Ctrl

Question Number : 27 Question Id : 146587327 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Y AT PR (GUAP) M & o Fferiaa & 2 i oit (@) &1 IuaiT fpar wirer 82
Options :

1465871305. ¥ Tab

1465871306. ¥ Enter

1465871307. ¥ Shift

1465871308. ¥ Ctrl

Question Number : 28 Question Id : 146587328 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
Which of the following statements is/are TRUE?

(i) CRT stands for Cathode-Ray Tube.

(ii) LCD is a non-emissive display device.
Options :

1465871309. ¥ Only (i)

1465871310. #* Only (ii)

1465871311. ¢ Both (i) and (ii)
1465871312. ¥ Neither (i) nor (ii)

Question Number : 28 Question Id : 146587328 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

frofafed & 9 3 /8 3 g 7752

(i) CRT 1 JUf =Y Cathode-Ray Tube (PUTS &) B
(ii)) LCD U R-Ioip (non-emissive) o fearzw %I
Options :

1465871309, ¥ Hdd (i)

1465871310. # I (ii)

1465871311, ¢ (i) 3TR (ii) G

1465871312, # Tl (i) R AT (ii)
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Question Number : 29 Question Id : 146587329 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Which of the following statements is FALSE?

Options :

1465871313. ¥ A CPU contains an ALU, a CU, and registers.

1465871314. ¥ An ALU does all the arithmetic and logic calculations.

1465871315. ¢ A CPU is also called the tertiary storage of a computer system.
1465871316. ¥ A CU controls the functioning of the hardware units of a computer system.

Question Number : 29 Question Id : 146587329 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

e # 4 oF 91 $3F 3 52

Options :

1465871313, % CPUH ALU, CU 3R IR 1A &

1465871314, % ALU G} SO Td oeb TUMTE HraT 71

1465871315, ¥ CPU & SR ReH &1 Jaigs Tugul (R Hi &8l oar g |
1465871316, * CU LR R B STSATR 31341 & HIU/HaRH &I HaEd BT 2|

Question Number : 30 Question Id : 146587330 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

With respect to CPU registers, PC stands for:
Options :

1465871317. ¢ Program Counter
1465871318. ¥ Program Carrier
1465871319. ¥ Parallel Counter
1465871320. ¥ Parallel Carrier

Question Number : 30 Question Id : 146587330 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0

CPU SRR & el H, pc b1 uf &4 gl
Options :

1465871317. % Program Counter (thum W)
1465871318. ¥ Program Carrier (mm
1465871319. # Parallel Counter (ﬁiﬁam
1465871320. % Parallel Carrier (SRl BIRER)

Question Number : 31 Question Id : 146587331 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
Which of the following options best describes the truthfulness of the below statements?

(i) Both RAM and ROM are random access memory.
(ii) EPROM and EEPROM are exactly same.

Options :

1465871321. # (i) - TRUE; (ii) - TRUE
1465871322. ¢ (i) - TRUE; (ii) - FALSE
1465871323. ¥ (i) - FALSE; (ii) - TRUE
1465871324. % (i) - FALSE; (ii) - FALSE

Question Number : 31 Question Id : 146587331 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

fou Tt famedl 7 @ 19 1 faee Rafifad wu=t &t gadr &1 gafaq gufa sar g2

(i) RAM 3{R ROM SHI ¥5H TR [@Tef=se i) J9R1 €1
(ii) EPROM 3R EEPROM fSdigdl Uab o g1 B

Options :

1465871321, # (i) - F; (ii) - T

1465871322, ¢ (i) - T; (ii) - T
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1465871323, % (i) - 3TH; (ii) - I
1465871324, % (i) - 3, (ii) - 3

Question Number : 32 Question Id : 146587332 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Which of the following software was developed by Microsoft?
Options :

1465871325. ¥ OpenOffice

1465871326. ¥ Linux

1465871327. % i0S

1465871328. ¢ PowerPoint 2013

Question Number : 32 Question Id : 146587332 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

faferad & ¥ & I 9HedTR Microsoft (WTSHIATTe) gRT faw i farar war Ut
Options :

1465871325, ¥ OpenOffice

1465871326. ¥ Linux

1465871327. ¥ i0S

1465871328. ¢ PowerPoint 2013

Question Number : 33 Question Id : 146587333 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

In Microsoft Excel 2013, arrange the following steps in the CORRECT sequence by which one can insert existing comments and notes in one
cell to another cell.

a) Go to the 'Home' tab -> Click the arrow below 'Paste' -> Click 'Paste Special'.

b) Select the cell/cells that contain the comments that you want to copy -> Press Ctrl + C and click the destination cell.
¢) To cancel the moving border, click another cell or press Esc.

d) In the 'Paste Special' dialog box, under Paste, click 'Comments' -> Click 'OK".

Options :

1465871329. ¢ b); a); d); ¢)
1465871330. ¥ a); b); d); )
1465871331, ¥ b); a); c); d)
1465871332. # b); d); a); ¢)

Question Number : 33 Question Id : 146587333 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
gg;?softsgel 2013 ® FofRad =R &1 w8t 1 & afud ok, O 13 oafed T 9d 4 gk 9 # A fewf (@) sk e
Cy |

a) 'Home (_Eﬁrl)' 9 TR SThR-> 'Paste (ﬁE)' CIE| ﬁﬁ (?ﬁ? & ﬁ'QTFD TR 3 Y > Paste Special (W @’-‘QT?D' R fFae 3|

%wéﬁ/@ﬁaﬁmaﬁmwﬁmﬁﬁaﬁl%mﬁtﬁmmﬁ%> Ctrl +Cmﬁ3mmﬁa(destination cell)tﬁw
|

¢) AT STER B 3T R & forg, forddt 3y I R e &3 T Esc o

d) 'Paste Special (UC TRIS) SN §idy H, URE & T84, 'Comments (HIH<) TR fGaH B -> '0K (31dh) R [Fad HL

Options :

1465871329. ¥ D), a), d), ¢)

1465871330. # a), b), d), c)

1465871331. ¥ b), a), ¢), d)

1465871332. # b), d), a), c)

Question Number : 34 Question Id : 146587334 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
State whether the following statements related to Excel are TRUE or FALSE.

a) You need to use the VLOOKUP function to find things in a table or a range by row.

b) FINDB function counts each double-byte character as 2 when you have enabled the editing of a language that supports DBCS and then set it as
the default language (Excel 2013).

¢) The FV function returns the present as well as the future value of an investment.

Options :
1465871333. ¢ a) — True; b) — True; c) — False
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1465871334. ¥ a) — True; b) — True; c) — True
1465871335. ¥ a) — False; b) — True; c) — False
1465871336. ¥ a) — True; b) — False; c) — False

Question Number : 34 Question Id : 146587334 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

frafeied & & W&t a1 Taa HuT Wy FR

a) 3O fordt aTferenT a1 Uie-fawaR & $© Wi & oY VLOOKUP WaR BT SUGHT BT SR 2 |

b) STE MU DBCS &1 YA T1as & JUIG B 39 1T § 3R R 38 fSWiee U (Excel 2013) & ¥ H Ye fha1 8 99 FINDB
TR Td® SIA-T3C Haex Bl 2 » wUH a3

¢) FV Tha¥ 37a%eHe & gadM & 1Y g 1w & A o) Red aar g

Options :

1465871333, ¢ a) - gl; b) — Hal; ¢) — Taid

1465871334, % a)— Wal; b)— gl ¢) - el

1465871335, % a) — TTEd; b) — WaT; ¢) — A

1465871336. % a)— Wal; b) - TTad; ¢) - TTad

Question Number : 35 Question Id : 146587335 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

In Microsoft Powerpoint 2013, which of the following options is NOT present in the 'Slides' group menu under the 'Home' tab?
Options :

1465871337. # Layout

1465871338. ¥ Reset

1465871339. # Section

1465871340. ¢ Clipboard

Question Number : 35 Question Id : 146587335 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Microsoft PowerPoint 2013 ff, 'Home (_EﬁTD' WP ded 'Slides (WRS)' U ﬁ:,_[ﬁ ﬁ?;rl%l@"d H Yo a1 fdbey Qﬁm %?
Options :

1465871337 ¥ Layout (T3MT3<)

1465871338, ¥ Reset (R¥T)

1465871339. * Section (W)

1465871340. ¥ Clipboard (%mﬁé)

Question Number : 36 Question Id : 146587336 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
Arrange the following steps in the CORRECT order by which one can insert a video in a Microsoft PowerPoint 2013 slide from YouTube.

a) Go to the 'Insert' tab -> Click 'Video' > Select 'Online Video'.

b) Click the slide that you want to add a video to.

¢) Select the video from the search results -> Click 'Insert'.

d) In the 'Search YouTube' box, type the name of the video that you want to insert -> Press Enter.

e) A rectangular-shaped video is placed on your slide, which you can move and resize as you like -> To preview your video on your slide, right-
click the rectangular-shaped video -> Select 'Preview' -> Click the play button on the video.

f) Switch to the 'Playback’ tab of the ribbon to make choices about how and when the video plays

Options :

1465871341, # a); b); d); ¢); e); )
1465871342. ¢ b); a); d); ¢); e); )
1465871343, ¥ b); a); ¢); d); ); ¢)
1465871344. ¥ b); d); ¢); a); e); f)

Question Number : 36 Question Id : 146587336 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
faferad =Rull &) T8 $H § Hafd ¥ Y B8 AR YouTube I Microsoft PowerPoint 2013 TS § dIf$T 30¢ B bl 3|

a) 'Insert (ST\‘TLP)' %HER\_ITI'\Q ->'Video (m' TR {3 B -> 'Online Video (3‘|y|7‘|?‘|'|3_"f m‘ ?ﬁl
b) 3G WS R e B3 oY 3y Teh SifSa Siie- amed § 1

¢) T f¥oteed | § Tl o1 79 B -> 'Insert (I) WR fFa® B '

d) 'Search YouTube' ST H, I S} &1 A1 ford 19 31a 379¢ 1 918 §, -> e gand |

3@ Teachingninja.in



¢) DTS ATTAHR dIfSTT 3MMUD! WSS TR W T 7, T 3T RIFTART PR Tobd & 3R S 18 I PR & Tohd & -> 3] Wes R
30 difSa 1 they am & T, sareR difsa R Wge-faas B > ey &1 997 R -> dIfSa &1 @ o W fFasd B

f) dif$aY HI 3R Hd @ BT 8, $HD IR T TG B P 1078 R & 'Playback (Wedh) & TR S|

Options :

1465871341. ¥ a); b); d); c); e); )

1465871342. ¥ b); a); d); ¢); e); f)

1465871343. # b); a); ¢); d); 1); e)

1465871344, ¥ b); d); ¢); a); e); f)

Question Number : 37 Question Id : 146587337 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

What is the full form of GUI?

Options :

1465871345. # Global User Interface
1465871346. % Geographical User Interface
1465871347. % Graphical User Interface
1465871348. ¥ Graphical User Intervention

Question Number : 37 Question Id : 146587337 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

GUI &1 guf &Y &1 82

Options :

1465871345. % Global User Interface (RIS JoRR 3C0H)
1465871346. ¥ Geographical User Interface (Uqlﬂllrtbwﬂ ok SB)
1465871347, ¢ Graphical User Interface (TTTh&d GoR §eX04)
1465871348. # Graphical User Intervention (‘Allrt\bch(ﬂ ok $CIATM)

Question Number : 38 Question Id : 146587338 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

State whether the following statements are TRUE or FALSE.

a) OpenOffice Writer is not a freeware.
b) Microsoft Word from the Microsoft Office suite is a freeware.
¢) Windows XP is an open-source operating system.

Options :

1465871349. ¢ a) — False; b) — False; ¢) — False
1465871350. ¥ a) — True; b) — False; ¢) — False
1465871351. * a) — True; b) — False; ¢) — True
1465871352. # a) — False; b) — True; ¢) — False

Question Number : 38 Question Id : 146587338 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

qamy fob FRafRad su= 98 & a1 e

a) OpenOffice Writer Tch IO :FGCT% |
b) Microsoft Office Y€ T Microsoft Word Udh THIaR %I
¢) Windows XP T 30 T TR Rieen 31

Options :

1465871349, ¢ a) — TTAId; b) - TTad; ¢) - TTad
1465871350. % a) — Hal; b) — TaId; ¢) — TaId
1465871351, % a) —|81; b) — Ted; ¢) — el
1465871352 % ) TTCd; b) — WET; ¢) - Tad

Question Number : 39 Question Id : 146587339 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
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Match the columns.

a) Cale i) UCWeb
b) Linux ii) Apache
¢) Microsoft Word iii) Red Hat

d) UC Browser

iv) Microsoft

1465871353, ¢ a —ii; b —iii; c —iv; d — i
1465871354, ¥ a—iv; b —iii; c —ii; d —i
1465871355, ¥ a—ii; b—i;c—iv; d—iii
1465871356, ¥ a—iii;b—ii;c—iv;d—1i

Question Number : 39 Question Id : 146587339 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

FITHAT &7 BT FL

a) Calc i) UCWeb
b) Linux i) Apache
c) Microsoft Word | iii) Red Hat
d) UC Browser iv) Microsoft

Options :

1465871353. ¢ a—ii; b—iii; c —iv;d —i
1465871354, % a—iv; b —iii; c —ii; d — i

1465871355. % a—ii; b—i; c—iv; d —iii
1465871356. ¥ a —iii; b—ii;c—iv;d—i

Question Number : 40 Question Id : 146587340 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Which of the following languages is NOT used for client-side validation?

Options :

1465871357. # JavaScript
1465871358. ¥ PHP
1465871359, ¥ ASP
1465871360. ¥ ASPNET

Question Number : 40 Question Id : 146587340 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

FASC-ggs AfewH (wHUA) & forg FRafefaa § foog | o7y T8 grar g2

Options :

1465871357. % JavaScript (Wm)

1465871358. ¥ PHP
1465871359. % ASP
1465871360. ¥ ASP.NET

Question Number : 41 Question Id : 146587341 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
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Match the columns and select the most appropriate option from those given below.

a) VB.NET i) Lightweight data-interchange format

b) JSON ii) Object-oriented programming language, implemented on the NET Framework.
c) PHP iii) An open source relational database management system

d) MariaDB iv) Object oriented scripting langnage

1465871361, ¥ a—ii; b —i; ¢ — iv; d —iii
1465871362. % a—i;b—ii; c —iv; d —iii
1465871363, ¥ a—ii; b —iii; c —iv; d —i
1465871364. # a—ii; b—i; ¢ —iii; d — iv

Question Number : 41 Question Id : 146587341 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

few =1v Faw @1 e &1 3R 798 39gEa F@ Reed #7173 Fi

a) VB.NET i) TTETAT TET-EITHS BRAT
b) JSON i) NET %5a-3% R SIad U& ITealae-HNTULS FamiaeT s7er
¢) PHP iii) TR 39T A e STy dneEe s
d) MariaDB iv) 3Teste-3fives B amr
Options :

1465871361. ¥ a—ii; b —i; ¢ —iv; d —iii
1465871362. % a—i;b—ii; c —iv; d —iii
1465871363, # a—ii; b —iii; c —iv; d —1i

1465871364, ¥ a—ii;b—1i;c—iii;d—iv

Question Number : 42 Question Id : 146587342 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

PowerShell is a task automation and configuration management framework from
Options :

1465871365. ¢ Microsoft

1465871366. * 1IBM

1465871367. # Sun Microsystem

1465871368. % HP

Question Number : 42 Question Id : 146587342 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

EICTEIN] P Th b HTAHTA 3R BIPTR HwiHe hH-ad 8|
Options :

1465871365, ¥ TTRH NG

1465871366. ¥ IBM

1465871367 % T AISHIRICH

1465871368. ¥ HP

Question Number : 43 Question Id : 146587343 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

What is Shell Script in Linux?

Options :

1465871369. ¥ Computer program designed to be run by the Linux shell
1465871370. ¥ GUI based computer program for Linux Shell
1465871371. ¥ Linux administrator command

1465871372. ¥ Linux Kernel Interface
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Question Number : 43 Question Id : 146587343 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

foror o Ot fepp e g 82

Options :

1465871369. ¢ Torad R GRT HaTiad e Ui
1465871370. % oo 1 & 1T GuI ST SHeex TRy
1465871371, ¥ ooy TsAfAeRH wHiS

1465871372 # e 1 S

Question Number : 44 Question Id : 146587344 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
Match the columns and select the most appropriate option from those given below.

a) DB2

i) Relational database management system by Microsoft

b) SQL Server

ii) Database product from IBM

c¢) Django

iii) Open source relational database management system

d) MariaDB

iv) High-level Python Web framework

Options :

1465871373. ¥ a—ii; b—1i; ¢ —iv; d —ii
1465871374, ¥ a—i;b—ii; c —iv; d —iii
1465871375. ¥ a—ii;b—iii;c—iv;d—1i
1465871376. ¥ a—ii; b—iv; c—i; d —iii

Question Number : 44 Question Id : 146587344 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

few a1v e 1 Bew F 3R Ta 39gFa 98 faweT &1 9w #:4

a) DB2

i) ATSFIETTFE F NereEer STy dasnie fwew

b) SQL Server

i) IBM T ST Wsae

c) Django

iii) 39T A R TRy daedEe Red

d) MariaDB

iv) g% oo Sy 39 hA-IF

1465871373. ¥ a—ii; b—1i; ¢ —iv; d — ii
1465871374. % a—1i;b—ii; ¢ —iv; d — iii
1465871375. ¥ a—ii; b —iii; c —iv; d —i
1465871376. ¥ a—ii; b —iv; c —i; d —iii

Question Number : 45 Question Id : 146587345 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
In security, is a set of circumstances that has the potential to cause loss or harm.

Options :

1465871377. ¢ threat
1465871378. ¥ vulnerability
1465871379. # control
1465871380. ¥ repudiation

Question Number : 45 Question Id : 146587345 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option

Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

WM H, Tt ufkfRufaat o1 g § o eifer an Jeam &t GyTae g1 81

Options :
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1465871377 ¥ 9 (threat)

1465871378, % GeRISfAICT (vulnerability)
1465871379, % &SId (control)
1465871380. % SRIHRUT (repudiation)

Question Number : 46 Question Id : 146587346 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
A valid email address must contain:
Options :

1465871381. ¢¥ @

1465871382, # #

1465871383, % http

1465871384, % www

Question Number : 46 Question Id : 146587346 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

ot a0t vt B Fraferfa & 9 frget 81 ot 22
Options :

1465871381. ¥ @

1465871382, % #

1465871383. ¥ http

1465871384, % www

Question Number : 47 Question Id : 146587347 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

An email address consists of which two parts?
Options :

1465871385. ¢ Email prefix and email domain

1465871386. ¥ Name and country
1465871387. ¥ Data and country
1465871388. ¥ Name and company

Question Number : 47 Question Id : 146587347 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0
PR Na A U PH- BT I e &2
Options :

1465871385, ¢ SHA WifthaT 3R AW S
1465871386, % HTH MR &=

1465871387, % BIeT 3R &

1465871388, * TH 3R U

Question Number : 48 Question Id : 146587348 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

The memos in the RFC document series contain technical and organizational notes about the internet. What is the full form of RFC?
Options :

1465871389. ¢ Request For Comments

1465871390. ¥ Request For Contents

1465871391. ¥ Recall For Comments

1465871392, ¥ Received For Comments

Question Number : 48 Question Id : 146587348 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

RFC &3S 4Gl & A1 8 ge-ie $ aR § deb-i1ob! 3R TTa-Teqe HIe 81d & | RFC &1 g &9 1 g 82
Options :

1465871389. ¢ Rehte BIR HHEH (Request For Comments)

1465871390. # ¥ehse IR m (Request For Contents)
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1465871391, ¥ Rpid BIR HHEH (Recall For Comments)
1465871392, % g B HHCH (Received For Comments)

Question Number : 49 Question Id : 146587349 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

The File Transfer Protocol is used for:

Options :

1465871393. # only to uploading a file to a server

1465871394. % only downloading a file from server

1465871395. ¢ uploading a file to a server and downloading a file from the server
1465871396. ¥ process communication

Question Number : 49 Question Id : 146587349 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

PISH CRIHR Ueihid T SUa FHafeiad & 9 fae faw far smar g?
Options :

1465871393, % Had YA} R B3 AUAS B & forg|

1465871394, % P IR T B3 SIS PR & farg |

1465871395, ¢ Th13d o) TR TR 3UAS 3R TR T T3el SIS B & g |

1465871396, ¥ Tfohdl AR (VR HRIAGIA) & fag|

Question Number : 50 Question Id : 146587350 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

Which type of network would you suggest for networking of a school building?
Options :

1465871397. ¥ WAN

1465871398. ¥ LAN

1465871399. ¥ MAN

1465871400. ¥ PAN

Question Number : 50 Question Id : 146587350 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical

Correct Marks : 1 Wrong Marks : 0

it wpa i o Aeafd & fau 8y fg UHR & Aedd &1 g ¢
Options :

1465871397. % WAN

1465871398. ¥ LAN

1465871399. ¥ MAN

1465871400. ¥ PAN
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